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1. VIPA QUICK START GUIDE 

This section describes how to quickly start using a standard VIPA system. Further details, specifications, 
and instructions on the VIPA are provided herein. 
 

1 2 3

4 5 6

7 8 9

Unpack the 7800FR frame and mount 
accordingly.

Use the power cords provided to 
connect to the 7800FR frame. 

Switch on the power supply from front of 
the frame.

Plug the Ethernet cable into Ethernet 
port 1 for 7867VIPA12, or port 2 for 
78767VIPA8 / 16 / 32 / –DUO.  Plug the 
other end of cable into the Ethernet 
switch.  Connect a PC / laptop to the 
same switch via Ethernet cable.

Set the IP address for the VIP card via 
the front card edge display using the 
toggle switch or push button.   

Power cycle the device after saving 
the IP address.

Using a web browser (ie. Internet 
Explorer, Fire Fox, etc) type the IP 
address of the VIP in the address line 
(for example:  192.168.9.50).  The VIP 
will display a web page containing the 
output resolution setting of the card.  Set 
the output resolution of the VIP to match 
the monitor connected to the VIP.

Using the web browser, navigate to the 
“Layout” section of the web page to 
load a factory stored layout.  

If no layouts appear then the device 
does not have any default layouts 
loaded. 

To create a new layout use the 
Maestro software. (See step 7)

To design new layouts for the VIP, 
install the Maestro software via the vs-
setup.exe installer provided with the 
VIP on a CD.  Follow the installation 
instructions to install the Maestro 
client.

Open Maestro by double clicking on 
the Maestro icon from the desktop.  

If opening Maestro for the first time you 
will be prompted to create a new 
system. In the dialog box, provide a 
name for the VIP and enter it’s IP 
address. 

Select the appropriate product type 
which matches the VIP being used (for 
example:  7867VIPA12, 7867VIPA8, 
etc.)

Once the new system is created, 
double click on the system icon to 
enter layout mode.

Select a display to control by double 
clicking the desired option.  

To get started quickly, recall a pre-
saved layout from the Maestro design 
folder. If you wish to create your own 
layout, start by building a new layout 
using the template windows and the 
sources from the source window.
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2. OVERVIEW 

The VIP Advanced DUO is the most advanced compact multi-image display processor technology 
available. It supports up to 3Gbps SDI inputs and up to two unique display outputs. The VIP-A DUO takes 
compact multi-image display to the next level. 
 
The VIP Advanced DUO is available in three sizes: 8 inputs with up to 2 outputs, 16 inputs with up to 2 
outputs, and 32 inputs with up to 2 outputs. The VIP-A DUO inputs are auto-sensing SD, HD, and 3Gbps 
(SMPTE 424M). Each VIP-A DUO input can be displayed in any size, position or aspect ratio on any 
display. Both display outputs from the VIP-A DUO are provided over DVI and HD-SDI, which are both 
available simultaneously. The VIP-A DUO provides the best quality input reproduction, borrowing the 
latest in video processing technology from Evertz industry acclaimed conversion products. 
 

The VIP Advanced DUO is a hot-swappable device, which can be populated in Evertz widely installed 
3RU 7800 multi-frame chassis with an option for redundant power supplies. 
 

The VIP Advanced DUO device is VistaLINK® - enabled, offering remote monitoring, control and 
configuration capabilities via Simple Network Management Protocol (SNMP). The VIP-A DUO is easily 
configurable via the web server interface or card edge. Similar to the MVP, layout creation can be 
performed in a live control environment using Evertz' Maestro™ software. Other key features include 
automatic aspect ratio adjustment on a source-by-source basis, graticule generation, VITC/HD time code 
decode, and much more. 
 
 
Key VIP™ Features: 

• Accepts 8 (VIPA8-DUO), 16 (VIPA16-DUO), 18 (VIPA18-DUO), 24 (VIPA24-DUO) or 32 (VIPA32-
DUO) inputs with embedded audio 

• Uses Evertz next generation image processing technology, which is the same technology used in 
conversion products 

• Auto-sensing HD/SD and 3Gbps (SMPTE 424M) inputs (3GHS version) 
• Supports display resolutions of up to 1920x1080p on both outputs simultaneously 
• Allows for full screen viewing of any input on both outputs 
• Supports both DVI and HD-SDI outputs (active simultaneously) 
• Provides support for dynamic under monitor displays and tallies from router and switcher 
• Supports advanced on screen graphics, including analog clocks, transparency control of objects, 

raised bezels and borders, drop shadows, and bitmap backgrounds 
• Supports true type font including non-Latin alphabets 
• Built-in graticule generator, user defined per window 
• Enables the decoding and display of VITC/HD time code (RP-188) 
• Devices can be easily cascaded together to expand the total number of images on the displays 
• Built-in video, audio, and data fault monitoring with on screen fault notification 
• VistaLINK® - capable for configuration and monitoring via SNMP 
• Minimal processing delay (~1 frame) 
• Real time control of display outputs via Maestro™ 
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Figure 2-1: 7867VIPA8-DUO-HS Block Diagram 
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Figure 2-2: 7867VIPA16-DUO-HS Block Diagram 
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Figure 2-3: 7867VIPA18-DUO-HS Block Diagram 
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Figure 2-4: 7867VIPA24-DUO-HS Block Diagram 
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Figure 2-5: 7867VIPA32-DUO-HS Block Diagram 
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3. INSTALLATION 

The 7867VIPA8-DUO-HS/3G, 7867VIPA16-DUO-HS/3G, 7867VIPA18-DUO-HS/3G, 7867VIPA24-DUO-
HS/3G and 7867VIPA32-DUO-HS/3G modules come with a companion rear plate.  The 7867VIPA8-DUO-
HS/3G module occupies 3 slots in a 7800FR frame, the 7867VIPA16-DUO-HS/3G occupies 4 slots in a 
7800FR frame, the 7867VIPA16-DUO-HS/3G-DIN* occupies 3 slots in a 7800FR frame, and the 
7867VIPA18-DUO-HS/3G-DIN, 7867VIPA24-DUO-HS-/3G-DIN and the 7867VIPA32-DUO-HS/3G-DIN 
modules occupy 5 slots each in a 7800FR frame.  For information on mounting the rear plate and inserting 
the module into the frame see section 3 of the 7800FR chapter. 
 

              
Figure 3-1: 7867VIPA8-DUO-HS and 7867VIPA8-DUO-3G Rear Plates 
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Figure 3-2: 7867VIP16-DUO-HS and 7867VIP16-DUO-3G Rear Plates 

        

Figure 3-3:, 7867VIPA16-DUO-HS-DIN* and 7867VIPA16-DUO-3G-DIN* Rear Plates  
*See section 15 Appendix A for information on the DIN connector. 
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Figure 3-4: 7867VIPA18-DUO-HS-DIN and 7867VIPA18-DUO-3G-DIN Rear Plates 

 

      
Figure 3-5: 7867VIPA24-DUO-HS-DIN* and 7867VIPA24-DUO-3G-DIN* Rear Plates 
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Figure 3-6: 7867VIPA32-DUO-HS-DIN* and 7867VIPA32-DUO-3G-DIN* Rear Plates 
 

3.1. VIDEO INPUTS AND OUTPUTS 

INPUTS: The 7867VIPA8-DUO-HS has 8 BNC connector inputs that auto sense 3Gb/s, HD-
SDI and SD-SDI, or 10-bit serial digital video signals compatible with the 
SMPTE 424M, SMPTE 292M and SMPTE 259M-C standards.  The 7867VIPA16-
DUO-HS has 16 BNC connector inputs that auto sense 3Gb/s, HD-SDI and SD-SDI, 
or 10-bit serial digital video signals compatible with the SMPTE 424M, SMPTE 
292M and SMPTE 259M-C standards. The 7867VIPA18-DUO-HS has 18 connector 
inputs that auto sense 3Gb/s, HD-SDI and SD-SDI, or 10-bit serial digital video 
signals compatible with the SMPTE 424M, SMPTE 292M and SMPTE 259M-C 
standards. The 7867VIPA24-DUO-HS has 24 connector inputs that auto sense 
3Gb/s, HD-SDI and SD-SDI, or 10-bit serial digital video signals compatible with the 
SMPTE 424M, SMPTE 292M and SMPTE 259M-C standards.The 7867VIPA32-
DUO-HS has 32 connector inputs that auto sense 3Gb/s, HD-SDI and SD-SDI, or 
10-bit serial digital video signals compatible with the SMPTE 424M, SMPTE 292M 
and SMPTE 259M-C standards. 

 
HD/SDI OUTPUT: When the output resolution of the card is set to 720p, 1080i, 1080p, 625i, and 525i 

this BNC connector has 10-bit serial digital video signals compatible with the 
SMPTE 424M, SMPTE 292M and SMPTE 259M-C standards.  When the output 
resolution of the card is set to other resolutions, this output will not be active. 

 
AUX IN/OUT:   Auxiliary serial data input/output. 
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3.2. GENLOCK REFERENCE  

To lock/time the output of the VIP to house reference the genlock input should be used. 
 
GENLOCK INPUT: The genlock input is applied to the 7800FR frame, which provides genlock to all 

7867VIPA modules installed in the frame.  The genlock signal may be NTSC or PAL 
colour black.  The reference input type is auto detected. The genlock reference 
input is terminated to 75 ohms. 

 

3.3. DVI VIDEO CONNECTIONS  

DVI OUTPUT:  This VESA DVI-I connectors provide DVI-D outputs suitable for driving a computer 
video monitor.  The 7867VIPA8-DUO-HS, 7867VIPA16-DUO-HS, 7867VIPA18-
DUO-HS, 7867VIPA24-DUO-HS, and the 7867VIPA32-DUO-HS have two DVI-D 
outputs.  The monitor must be capable of scanning at the line and pixel rate of the 
video input standard you are using.  The following resolutions are supported by the 
VIP module at both 50Hz and 60Hz: 

 
XGA (1024x768) SXGA (1280x1024) UXGA (1600x1200) 

WXGA (1280x768) 720p (1280x720) 576p/625i(720x576) 
480p/525i (720x480) WXGA Alt (1366x768) SXGA+(1400x1050) 

WSXGA+(1680x1050) 1080p(1920x1080) WUXGA(1920x1200) 
XGA (1024x768) SXGA (1280x1024) UXGA (1600x1200) 

WXGA (1280x768) 720p (1280x720) 576p/625i(720x576) 

Table 3-1: Supported Resolutions at 50Hz and 60Hz 
 
 Recommended maximum cable lengths: 

• DVI digital max length = 3 meters, or 10 feet 
• VGA analog max length = 5 meters, or 15 feet 
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3.4. GENERAL PURPOSE INPUTS AND OUTPUTS 

GPI interfacing with the 7867VIPA is possible through 4 general purpose inputs (pins 10, 11, 12, 13) and 2 
general purpose outputs (pins 4, 9) available on the HD-15 connector on the rear plate of the module.  The 
GPIs are active low with internal pull-up resistors (4.7k Ohms) to +5 V.   To make an input active, lower 
the signal to near ground potential (i.e. connect to shell or chassis ground). This can be done with a 
switch, relay, TTL drive, GPO output, or using another similar method.  Figure 3-7 shows the input circuit 
for the general-purpose inputs.  Figure 3-9 shows an example of how to interface the VIP GPI inputs to 
higher voltage systems. 
 

GND

To Internal
Circuit

4.7 kΩ

GPI

+ 5 Volts

 
Figure 3-7: GPI Input Circuitry 

 
The GPOs are active low with internal pull-up (10kΩ) resistors to +5 V. When the output goes low, it is 
able to sink up to 10 mA; when the output goes high, the signal will go high (+5 V).  Do not draw more 
than 100µA from the output.  Figure 3-8 shows the circuit for the general-purpose output. 
 

From Internal
Circuit

10k Ω

+ 5 Volts

GND

GPO
10 Ω

 
Figure 3-8: GPO Output Circuitry 
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AXICOM
1M06 Relay

(24V = working voltage)

1N4148
Diode

24V = working 
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Example: Control Device

24VDC
 (working voltage)

GPO

VIP GND

VIP GND GPI of VIP

note:  the control device 
and the VIP GNDs must 

be tied together

  
Figure 3-9: Interfacing GPIs to a High Voltage GPI System 
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3.5. ETHERNET NETWORK CONNECTIONS 

ETHERNET1 / 2: These RJ-45 connectors are Ethernet ports which facilitate control via VistaLINK® 
PRO or Maestro software.  It is also used for FTP firmware upgrades.  The VIP 
module comes delivered from the factory with Ethernet 2 as the default active port; 
Ethernet 1 is disabled and is not used at this time. 

 

 
Figure 3-10: Rear Plate – Ethernet Ports 

 
The 7867VIPA8-DUO-HS, 7867VIPA16-DUO-HS, 7867VIPA18-DUO-HS, 7867VIPA24-DUO-HS, and the 
7867VIPA32-DUO-HS are designed to be used with either 10Base-T (10 Mbps) or 100Base-TX (100 
Mbps) also known as Fast Ethernet, twisted pair Ethernet cabling systems.  When connecting for 10Base-
T systems, category 3, 4, or 5 UTP cable as well as EIA/TIA – 568 100Ω STP cable may be used.  When 
connecting for 100Base-TX systems, category 5 UTP cable is required.  Make the network connection by 
plugging one end of a “straight through” cable into the RJ-45 receptacle of the 7867VIPA8-DUO-HS, 
7867VIPA16-DUO-HS, 7867VIPA18-DUO-HS, 7867VIPA24-DUO-HS, or the 7867VIPA32-DUO-HS and 
the other end into a port of the supporting hub.  If you are connecting the VIPA card directly to an Ethernet 
port on a computer you will have to use a “crossover” cable. 
 
The straight-through RJ-45 cable can be purchased or can be constructed using the pinout information in 
Table 3-2.  A colour code wiring table is provided in Table 3-2 for the current RJ-45 standards (AT&T 258A 
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or EIA/TIA 258B colour coding shown). Also refer to the notes following the table for additional wiring 
guide information.  

Pin # Signal EIA/TIA 568A AT&T 258A or 
EIA/TIA 568B 

10BaseT 
or 100BaseT 

1 Transmit + White/Green White/Orange X 
2 Transmit – Green/White or White Orange/White or Orange X 
3 Receive + White/Orange White/Green X 
4 N/A Blue/White or Blue Blue/White or Blue Not used (required) 
5 N/A White/Blue White/Blue Not used (required) 
6 Receive – Orange/White or Orange Green/White or Green X 
7 N/A White/Brown White/Brown Not used (required) 

Pin 
1 

 
8 N/A Brown/White or Brown Brown/White or Brown Not used (required) 

Table 3-2: Standard RJ45 Wiring Colour Codes 
 
Note the following cabling information for this wiring guide: 
• Only two pairs of wires are used in the 8-pin RJ-45 connector to carry Ethernet signals. 
• Even though pins 4, 5, 7 and 8 are not used, it is mandatory that they be present in the cable. 
• 10BaseT and 100BaseT use the same pins; a crossover cable made for one will also work with the 

other. 
• Pairs may be solid colours and not have a stripe. 
• Category 5 cables must use Category 5 rated connectors. 
 
The maximum cable run between the 7867VIPA8-DUO-HS, 7867VIPA16-DUO-HS, 7867VIPA18-DUO-
HS, 7867VIPA24-DUO-HS, or 7867VIPA32-DUO-HS and the supporting hub is 300 ft (90 m).  The 
maximum combined cable run between any two end points (i.e. 7867VIPA8-DUO-HS and PC/laptop via 
network hub) is 675 feet (205 m). 
 
Devices on the Ethernet network continually monitor the receive data path for activity as a means of 
checking that the link is working correctly.  When the network is idle, the devices also send a link test 
signal to one another to verify link integrity. The rear panel is fitted with two LEDs to monitor the Ethernet 
connection.  
 
10/100: This Amber LED is ON when a 100Base-TX link is last detected.  The LED is OFF 

when a 10Base-T link is last detected (the LINK LED is ON). Upon power-up the 
LED is OFF as the last detected rate is not known and therefore defaults to the 
10Base-T state until rate detection is complete.  

 
LN/ACT: This dual purpose Green LED indicates that the 7867VIPA card has established a 

valid linkage to its hub, and whether the 7867VIPA card is sending or receiving 
data.  This LED will be ON when the 7867VIPA card has established a good link to 
its supporting hub.  This gives you a good indication that the segment is wired 
correctly. The LED will BLINK when the 7867VIPA card is sending or receiving data. 
The LED will be OFF if there is no valid connection. 

 
In order to use the Ethernet connection you will have to configure the IP addresses for your network.  See 
section 7.2.1. 
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3.6. LTC AND SERIAL DATA INPUTS (AUXILIARY INTERFACE) 

The 7867VIPA has an LTC input and a serial data port available on the HD-15 connector on the modules 
rear plate.  
 
Table 3-3 identifies the pin assignments for the general purpose HD-15 connector mounted on the rear 
plate for the VIP Advanced Duo modules. 
 

 
Figure 3-11: Rear Plate – Port for Attaching the HD-15 
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3.6.1. Rear Panel HD-15 Connector 

PIN FUNCTION DESCRIPTION 

1 
RS-422:  RX+ 

(CTSM) 
Used for RS-422 communication – VIP RX+, to be connected to 
upstream devices TX+ 

2 
RS-422:  TX+ 

(RTSM) 
Used for RS-422 communication – VIP TX+, to be connected to 
upstream devices RX+ 

3 LTC + LTC interface, positive terminal 

4 GPO1 General purpose output 1 

5 GND GND 

6 

RS-23:  RX 

RS-422:  RX- 

(RXDM) 

Used for RS-232 communication – VIP RX, to be connected to 
upstream devices TX.  Also used for RS-422 communication – VIP 
RX-, to be connected to upstream devices TX- 

7 

RS-232:  TX 

RS-422:  TX- 

(TXDM) 

Used for RS-232 communication – VIP TX, to be connected to 
upstream devices RX.  Also used for RS-422 communication – VIP 
TX-, to be connected to upstream devices RX- 

8 LTC - LTC interface, negative terminal 

9 GPO0 General purpose output 0 

10 GPI3 General purpose input 3 

11 GPI0 General purpose input 0 

12 GPI1 General purpose input 1 

13 GPI2 General purpose input 2 

14 AES_OUT0 AES output 0 – unbalanced.  To be used for monitoring embedded 
audio from source.  Assigned normally to display 1. 

15 AES_OUT1 AES output 1 – unbalanced.  To be used for monitoring embedded 
audio from source.  Assigned normally to display 2. 

Table 3-3: HD 15 Pin-Out 
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Figure 3-12: 7867VIPA8/16/32 HD-15 General Purpose Pin-Out 
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4. TECHNICAL DESCRIPTION 

4.1. SPECIFICATIONS 

4.1.1. Serial Video Inputs 
Standard:  3Gb/s (SMPTE 424M) (-3GHS only) 
 HD-SDI (SMPTE 292M)  
 SD-SDI (SMPTE259M-C) 
Number of Inputs:  8 (7867VIPA8-DUO-HS), 16 (7867VIPA16-DUO-HS), 18 (7867VIPA18-DUO-

HS), 24 (7867VIPA24-DUO-HS) or 32 (7867VIPA32-DUO-HS) 
Connector: BNC IEC 61169-8 Annex A 
Equalization:  Automatic to 100m (Belden 1694A) 
Return Loss:  > 15dB up to 270Mb/s 
Embedded Audio:  SMPTE 272M-A 
 

4.1.2. Serial Video Output 
Standard:  Selectable HD/SD serial monitoring output (720p, 1080i, 625i, 525i)  
Number of Outputs:  2 
Connector:  BNC IEC 61169-8 Annex A 
Signal Level:  800mV nominal 
DC Offset:  0V ±0.5V 
Rise and Fall Time:  200ps nominal (HD), 740ps nominal (SD) 
Overshoot:  < 10% of amplitude 
 

4.1.3. Background (Computer) Video Input 
Standard:  GLINK (Evertz proprietary) requires video to GLINK formatter  
 (i.e. 7707RGBT-GC) 
Number of Inputs:  1 
Connector:  BNC IEC 61169-8 Annex A 
Input Resolution:  640x480 (VGA) to 1600x1200 (UXGA) 
Signal Level:  75Ω 
 

4.1.4. Display Video Output 
Standard:  VESA (DVI-D) up to 1080p (1920x1080) 
Number of Outputs:  2 
Connector:  DVI-I 
Video:  1V p-p TMDS 
 60Hz refresh 
Impedance:  100Ω differential 
 

4.1.5. Genlock Input 
Type:  NTSC/PAL colour black 
Level:  1V p-p nominal  
Connector:  Requires 7800FR  
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4.1.6. General Purpose Interface I/O (GPI/GPO) 
Number of Inputs:  4 (pins 10, 11, 12, 13) 
Number of Outputs:  2 (pins 4, 9) 
Type: 

GPI:  Opto-isolated, active low with internal pull-ups to +5V 
GPO:  Relay closure to ground 

Input Signal:  Closure to ground 
Connector:  HD-15 
 

4.1.7. Input/Output Serial Port 
Number of Ports:  1 RS-232 (pins 6, 7) or 1 RS-422 (pins 1, 2, 6, 7) 
Connector:  HD-15 
Baud Rate:  Up to 1Mbaud 
Format:  Configurable for various UMD Interfaces 
 

4.1.8. AES Output (unbalanced) 
Number of outs:  2 unbalanced outs (pins 14, 15) 
Connector:  HD-15 
Audio format:  AES-EBU 
 

4.1.9. Ethernet 
Network Type:  Fast Ethernet 100 Base-TX 1EEE, 802.3U standard for 100Mbps base band 

CSMA/CD local area network 
Connector:  RJ-45 x 2 
 

4.1.10. Electrical 
Voltage:  +12V DC 
  
Power:  80W (7867VIPA32, 7867VIPA24, and 7867VIPA18) 
 72W (7867VIPA16) 
 68W (7867VIPA8) 
EMI/RFI:  Complies with FCC Part 15, Class A, EU EMC Directive 
 

4.1.11. Physical 
Number of Slots:  3 (VIPA8-DUO) 
 3 (VIPA16-DUO-DIN) 
 4 (VIPA16-DUO) 
 5 (VIPA18-DUO, VIPA24-DUO, and VIPA32-DUO) 
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5. STATUS LEDS 

5.1. MODULE STATUS LEDS 

MODULE STATUS: This Green LED will be on when the module is operating properly. 
 

LOCAL FAULT: This Red LED makes it easy to identify one module in a frame that is missing an 
essential input or has another fault. 
 
The Red LED will blink on and off if the microprocessor is not running.   
 
The Red LED will be on when there is a fault in the module power supply or a 
user configurable error condition exists (as configured through the Frame 
Status Trigger menu option). 

 

5.2. VIDEO STATUS LED AND CARD EDGE 4-CHARACTER DISPLAY 

Some key user components can be found at the card edge: 
1. Toggle Switch 
2. Local Fault Status LED 
3. 4 Character Dot Matrix Display 
4. Push Button 

 
• Toggle Switch:  This component will become active once the card has completed booting.   
  Its primary function is to navigate through the menu system. 

 
• Local Fault Status LED: This component will be set upon initial power up to red.  Once the  

card is in a normal operating mode, it will be set to green.  If the card has booted, 
and the LED remains red or becomes red, this indicates an internal error. 

 
• 4 Character Dot Matrix Display: This component will become active once power is applied to  

the card.  This component is used to relay text-based information to the user.  It 
will be used to scroll build and card information, or display the menu options to 
the user.  

 
• Push Button:  This component will become active once the card has completed booting.  It  

is primarily used for navigating through the menu system. 
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6. USER JUMPERS 

Several jumpers are used to preset various operating modes.  Figure 6-1 shows the location of the 
jumpers on the bottom and top boards respectively. 
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Figure 6-1: Location of Jumpers (7800G4X) 

 

6.1. SELECTING WHETHER LOCAL FAULTS WILL BE MONITORED  
BY THE GLOBAL FRAME STATUS 

The FRAME STATUS jumper J4, on the bottom board, determines whether local faults (as shown by the 
Local Fault indicator) on the bottom board will be connected to the 7800FR frame's global status bus. 
 
FRAME STATUS: To monitor faults on this module with the frame status indicators (on the Power 

Supply FRAME STATUS LED's and on the Frame's Fault Tally output) install this 
jumper in the On position.  (Default) 

 
When this jumper is installed in the Off position local faults on this module will not 
be monitored. 

 

6.2. CONFIGURING THE MODULE FOR FIRMWARE UPGRADES VIA SERIAL PORT 

RUN/UPGRADE: The RUN/UPGRADE jumper on the bottom board is used when firmware upgrades 
are being done to the module.  For normal operation it should be installed in the 
RUN position.  See the Upgrading Firmware chapter in the front of the binder for 
more information. 

 
To upgrade the firmware in the module unit via the serial port pull it out of the frame.  
Move the RUN/UPGRADE jumper into the UPGRADE position.  Install the Upgrade 
cable provided (located in the vinyl pouch in the front of the binder) onto SERIAL 
header J7 at the card edge. Re-install the module into the frame.  Run the upgrade 
as described in section 9.2.  Once the upgrade is complete, remove the module 
from the frame, move the jumper into the RUN position, remove the upgrade cable 
and re-install the module.  The module is now ready for normal operation. 

 

 
The serial port method of upgrading the firmware will take over 15 minutes and is 
not recommended unless the FTP method fails. 
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7. MODULE CONFIGURATION 

The parameters of the VIP™ module are configured through the following tools: 
• Module Card-edge: Enables the user to set the module’s network settings. 
 
• Module Serial Port: Enables the user to set the module IP address and TRAP destination IP 

addressing, network identification. 
 

• Web Server Interface:  A web browser can be used to connect to a VIP.  This interface does not 
require any additional software to be installed other than your standard web browser software (i.e. 
Internet Explorer, Fire Fox, etc). 

 
• Maestro: This is a software configuration tool included with every VIP module used to design 

preset layouts for one or multiple VIP systems, along with all on screen display elements including 
audio bar graphs, UMD, tallys and fault messages. Specifically colour, transparency, borders, etc. 
that are all included in the final display output.  

 
• VistaLINK® PRO: An SNMP software tool that is used to set the fault monitoring thresholds and 

durations for each VIP module detected on the network and/or for fault message (TRAP) receipt 
and data logging. 

 
• Module Card-edge DIP Switches: Only to be enabled during boot-up sequence, DIP switches 

enable the following cases/features: 
1. Used to clear high level NV– DIP switch 2, 3 and 4 open (to the right) 
2. Used to clear low level NV– DIP switch 2, and 4 open (to the right) 
3. If none of the above cases/features are required, leave all DIP switches closed (to the left) 

 

7.1. CONFIGURING THE MODULE VIA THE CARD EDGE MENU 

When you are not in the menu system, the user will see product identification and build revision across the 
4 character dot matrix display.  
 
To enter the menu on the card-edge, press the card-edge pushbutton once and follow the menu headings 
on the 4-character display.  To adjust any parameter, use the toggle switch to move up or down to the 
desired parameter and press the pushbutton.  Using the toggle switch, adjust the parameter to its desired 
value.  If the parameter is a numerical value, the number will increase if you push up on the toggle switch 
and decrease if you push down on the toggle switch.  If the parameter contains a list of choices, you can 
cycle through the list by pressing the toggle switch in either direction.  The parameter values are changed 
as you cycle through the list. 
 
When you have stopped at the desired value, depress the pushbutton.  This will return to the parameter 
select menu item you are setting (the display shows the parameter name you were setting).  To change 
another parameter, use the toggle switch to select other parameters.  If neither the toggle switch nor 
pushbutton is operated for several seconds the card edge control will exit the menu system and return to 
an idle state.  
 
On all menus, there is an extra selectable item: BACK. Selecting BACK will take you to the previous menu 
(the one that was used to get into the current menu).  On the main menu, BACK will take the user to the 
normal operating mode (indicated by the moving line on the card edge display). 
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Table 7-1 gives a brief description of the top level of the menu tree that appears when you enter the card 
edge menu system.  Selecting this item will take you down into the next menu level to set the value of that 
parameter. The details of those parameters are described in section 7.1.1. 
 

NET  
Menu item for setting the devices IP address*   
Note: After setting the IP address and saving, the card must be power cycled for 
changes to take effect. 

Table 7-1: Top Menu Structure  

7.1.1. Configuring the Display 
NET  

BACK 
IP 
NMSK 
GTWY 
BCST 
DHCP 
SAVE 
 

 
BACK: Option to navigate back up one level from the current menu position. This is 
the factory default menu option. 
 
IP: (NETWORK ADDRESS): Option for setting the IP address for the VIP module. All 
4 octets must be set. 
NOTE:  After changing the IP address, navigate to the SAVE option in order to store 
the IP address for the device, then power cycle the device for the address to take 
effect. 
 
NMSK (NETWORK MASK): Option for setting the net mask for the VIP module. 
NOTE:  After changing the Netmask, navigate to the SAVE option in order to store 
the setting for the device, then power cycle the device for the address to take effect. 
 
GTWY (GATEWAY ADDRESS): Option for setting the gateway address for the VIP 
module. 
 
NOTE:  After changing the Gateway address, navigate to the SAVE option in order to 
store the setting for the device, then power cycle the device for the address to take 
effect. 
 
BCST (BROADCAT ADDRESS): Option for setting the broadcast address for the VIP 
module. 
NOTE:  After changing the Broadcast address, navigate to the SAVE option in order 
to store the setting for the device, then power cycle the device for the address to take 
effect. 
 
DHCP (DHCP ENABLE/DISABLE): Option for enabling or disabling DHCP for the VIP 
module, normally set to disabled. 
NOTE:  After changing the DHCP, navigate to the SAVE option in order to store the 
setting for the device, then power cycle the device for the address to take effect. 
 
SAVE (SAVE NETWORK SETTINGS): Option for saving changes made to the above 
options.  The user is required to save only a single time for multiple changes to be 
applied. 
 
NOTE:  After saving, the VIP modules must be power cycled. 
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7.2. CONFIGURING THE MODULE USING THE MODULE SERIAL PORT 

Through the card-edge’s serial port, and using the serial 7800 upgrade cable connected to a PC’s serial 
port running HyperTerminal (or equivalent), the VIP module’s IP address, subnet, and SNMP TRAP 
destination address are identified. The 7800 upgrade cable supplied with the 7800FR frame is a multi-
coloured ribbon cable with a six pin header socket on one end and a female 9 pin D connector on the 
other end, (Evertz part number WA-S76) which is normally in the vinyl pouch at the front of the manual 
binder.   
 
Configure the port settings of the terminal program as follows: 
 

Baud 115200 
Data bits 8 
Parity None 
Stop bits 2 
Flow Control None 

 
Once the card is powered-up, the HyperTerminal connection displays boot-up status information and once 
complete, ends with the “Status Message” as shown below: 
 

Initialization Completed - 7867VIP Running 

 
Press the <ENTER> key to view the main Menu.  In the Main Menu, the following options are present for 
module configuration. Once changes have been completed and saved, the VIP module should be power-
cycled for the changes to take effect.  
 
--------------------------------------------------------- 
|                        Main Menu                            | 
|                (7867VIPA8-DUO-HS 1.0.0)        | 
 --------------------------------------------------------- 
(1) Network Configuration 
(2) Onboard Server Configuration 
(3) SNMP Configuration 
(4) Under Monitor Display Setup 
(5) Auxiliary Serial Port Setup 
(6) SNTP Source 
(7) Network Audio Configuration 
(8) Nielsen Configuration 
(9) Engineering/Debug 
 
(X) Exit 
>  
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7.2.1. Network Configuration  
1) Network Configuration – This menu option is used to set the IP parameters for this VIP module. 
 ------------------------------------------------ 
ENET: 1  MAC: 00:02:c5:10:5e:73 
 
IP address:        192.168.9.62 
Netmask address:   255.255.255.0 
Gateway:           0.0.0.0 
Broadcast address: 192.168.9.255 
DHCP/Hotswap mode: Off 
 ------------------------------------------------ 
(1) Set IP Address 
(2) Set Netmask 
(3) Set Gateway 
(4) Set Broadcast Address 
(5) Set DHCP/Hotswap mode 
 
(S) Save and Exit 
(X) Exit 
 

7.2.2. On Board Server Setup 
2) On Board Server Configuration – This menu option is used to set up the internal server properties of 
the VIP module. 
 
Server: The Server should be enabled for normal VIP operation.  In a system where the VIPA external PC 
based server is used the server should be disabled. 
 
GPId:  The GPId should be enabled when using GPIs to load layouts on the VIP module. 
 
VGPId: The VGPId should be enabled when using virtual GPIs to load layouts on the VIP module. 
 
DCPd: The DCPd should be enabled when using the 3000DCP desktop control panel with the VIP. 
 
SYMPHd: The SYMPHd should be enabled when using the Symphony Third Party protocol.  The third 
party protocol allows for external control devices to change layouts on the VIP.  The communication of this 
control is done using TCP/IP default port = 9750.  Please see Evertz’ Symphony Protocol version 1 for 
more details regarding the protocol itself. 
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 ------------------------------------------------ 
Onboard Server: Enabled 
Onboard GPId: Disabled 
Onboard VGPId: Disabled 
Onboard DCPd: Disabled 
Onboard SymphD: Disabled 
 ------------------------------------------------ 
(1) Display connection status 
(2) Enable server 
(3) Enable gpid 
(4) Enable vgpid 
(5) Enable dcpd 
(6) Enable symphd 
 
(S) Save and Exit 
(X) Exit 
> 
 

7.2.3. SNMP Configuration  
3) SNMP Configuration – This menu option is used to set the TRAP destination IP address which 
originates at this VIP (if enabled). 
 
---------------------------------- 
No Trap Destinations Assigned 
---------------------------------- 
 
(1) Set Trap IP Address 
(2) Remove Trap IP Address 
(3) Community Strings 
 
(S) Save and Exit 
(X) Exit 
> $ 
 

7.2.4. UMD Setup 
4) UMD Setup – Set the dynamic UMD. 
 
The UMD Setup is as follows: 
 
Protocol:   Image Video 
Input Type: Serial 
 
 ------------------------------------------------  
 
(1) Set protocol 
 
(S) Save and exit 
(X) Exit without saving 
 
Select UMD Protocol: (1 - 3) 
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1. Image Video 
2. Philips ASCII 
3. XY Integrator 
4. TSL 3.1 
5. Echo 
6. TSL 4.0 
7. Harris Image Video 

 
Select Input Type: (1 - 2) – Option for Image Video Protocol only 
 1. Serial 
 2. Network 
 

7.2.5. Auxiliary Serial Port Setup 
5) Auxiliary Serial Port Setup – If utilizing the serial port for dynamic UMD information, use this menu 
option to set the serial port parameters. 
 
 Auxiliary Serial Port Setup: (Use the following settings to configure the auxiliary serial port) 
 
 Baud Rate: 9600 
 Data Bits: 8 
 Parity:            None 
 Stop Bits: 2 
 Standard:       RS-232 
 
 ------------------------------------------------  
(1) Set baud rate 
(2) Set number of data bits 
(3) Set parity 
(4) Set number of stop bits 
(5) Set standard 
 
(S) Save and exit 
(X) Exit without saving 
 

7.2.6. SNTP Setup – Network Time Protocol 
6) SNTP Source – This menu option is used to set the NTP server source IP address.  Set the IP address 
for the NTP server on the network.  The VIP must be on the same network in order to contact the server.  
This menu will also display the last updated network time. 
 
------------------------------------------------ 
Active sntp source: 0.0.0.0 
New sntp source: 0.0.0.0 
Last time sntp updated at 
sntp time: 0:0:0 
 ------------------------------------------------ 
(1) Set SNTP Source Address 
 
(S) Save and Exit 
(X) Exit 
> 
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7.2.7. Network Audio Setup – Future Enhancement Feature 
7) Network Audio Setup – This option is not available at the time of the manual update.  
 
--------------------------------------------------------- 
           Network audio to video input mapping 
 ID      IP address                Video Inputs 
                        1  2  3  4  5  6  7  8  9 10 11 12 
  0    192.168.9.62     * 
 --------------------------------------------------------- 
            Audio source to video input mapping 
Channel                       Video inputs 
pairs     1  2  3  4  5  6  7  8  9 10 11 12 
 1 (1 2) 1  .  .  .  .  .  .  .  .  .  .  . 
 2 (3 4)  .  .  .  .  .  .  .  .  .  .  .  . 
 3 (5 6)  .  .  .  .  .  .  .  .  .  .  .  . 
 4 (7 8)  .  .  .  .  .  .  .  .  .  .  .  . 
 --------------------------------------------------------- 
(1) Set video input 
(2) Clear video input 
(3) Set audio source for video input 
(4) Clear audio source for video input 
 
(S) Save and Exit 
(X) Exit 
 

7.2.8. Nielsen Configuration 
8) Nielsen Monitoring Setup – This menu option is used for configuring the IP interface to the 7867ND-
HD Nielsen decoder product for the display of Nielsen ratings code.  
 
--------------------------------------------------------- 
           Network audio to video input mapping 
 ID      IP address                Video Inputs 
                        1  2  3  4  5  6  7  8  9 10 11 12 
  0    192.168.9.62     * 
 --------------------------------------------------------- 
            Audio source to video input mapping 
Channel                       Video inputs 
pairs     1  2  3  4  5  6  7  8  9 10 11 12 
 1 (1 2) 1  .  .  .  .  .  .  .  .  .  .  . 
 2 (3 4)  .  .  .  .  .  .  .  .  .  .  .  . 
 3 (5 6)  .  .  .  .  .  .  .  .  .  .  .  . 
 4 (7 8)  .  .  .  .  .  .  .  .  .  .  .  . 
 --------------------------------------------------------- 
(1) Set video input 
(2) Clear video input 
(3) Set audio source for video input 
(4) Clear audio source for video input 
 
(S) Save and Exit 
(X) Exit 
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7.3. WEB SERVER INTERFACE 

A simple web server interface is provided for control over the VIP.  This interface is accessed remotely via 
an IP connection to the device from a PC.  To interface to the VIP and control using the web interface 
simply set the IP address on the VIP, place a PC on the same network either directly connecting to the 
VIP via cross over Ethernet cable or through a network switch. Ensure the PC’s network adapter is set to 
the same network as the VIP.  For example, if the VIP is set to 192.168.9.100, then set the PC to 
192.168.9.xxx (any value between 2 and 254 excluding the value 100 which is the VIP module).  Once the 
PC is confirmed to be on the same network as the VIP (use PING in DOS window to confirm), open a web 
browser (i.e. Internet Explorer, or Fire Fox, etc) in the navigation toolbar (address bar) and type the IP 
address of the VIP (for example, 192.168.9.100).  Upon connecting the VIP, the VIP will display the screen 
identified in Figure 7-1, where the card provides access to control using standard web interface navigation 
tools. 
 
The web browser is easy to navigate. Simply select a major category, either Card Setup or Layout, and 
then use the sub categories in the main body of the page to navigate and setup specific options for the 
module.  To ensure that the settings being viewed are correct, first press the “Update” button on the page 
to refresh the view.  Secondly, make a change using the simple drop down dialog boxes.  After a change 
has been made, press the Save button to apply the change to the card. Some changes may require the 
card to be restarted or reset.  The following sections detail the various card options available through the 
web client interface. 
 

7.3.1. Card Setup:  Display Setup 
The Display Setup screen enables the user to configure the output properties for the VIP module. 
 

• Output Resolution: This parameter enables the user to select the resolution format for the DVI  
output. 

 
• Refresh Rate:   This parameter enables the user to select the refresh rate for the output. 
 
• Horizontal Offset:  This parameter enables the user to adjust the position of the active picture in  

respect to the amount of horizontal offset for the analog output signal. 
 
• Vertical Offset:  This parameter enables the user to adjust the position of the active picture in  

respect to the amount of vertical offset for the analog output signal. 
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Figure 7-1: Display Setup 

7.3.2. Card Setup:  Network Setup 
The Network Setup screen enables the user to configure the network properties of the VIP module. 
 

• IP Address: This parameter enables the user to set the IP address for the device. 
 
• Netmask:  This parameter enables the user to set the Netmask for the device. 
 
• Gateway:  This parameter enables the user to set the Gateway address for the device. 
 
• Broadcast:  This parameter enables the user to set the Broadcast address for the device. 
 
• DHCP:   This parameter allows the user to enable or disable DHCP for the device. 
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Figure 7-2: Network Setup 

 

7.3.3. Card Setup:  SNMP Setup 
The SNMP Setup enables the user to configure the SNMP trap destinations for up to five trap destinations 
that can be supported. 
 

• Trap Destination 1 to 5: This parameter enables the user to enter an IP Address for the  
 SNMP server. 

  

 
Figure 7-3: SNMP Setup 
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7.3.4. Card Setup:  UMD Setup 
The UMD Setup enables the user to configure the UMD protocol for the VIP. 
 

• Protocol: This parameter enables the user to select the appropriate UMD protocol.  The  
 options include: 
 

 Image Video: Supports both Ethernet and serial connections 
 Philips ASCI (VMSI 3000): Support for Jupiter control system (requires additional 

configuration files) 
 XY Integrator: Support for Harris routers (requires additional configuration files) 
 TSL 3.1: TSL standard protocol, support for both Ethernet and serial 
 TSL 4.0: TSL advanced protocol, support for both Ethernet and serial 
 ECHO: Echoes commands in bound on auxiliary serial port to configuration serial 

port (upgrade port) 
 

• Input Type:  This parameter enables the user to select the format for the input. The format will be  
either serial or Ethernet (requires an IP address port to be defined in the next 
property) 

 
• Network Port: This parameter enables the user to set the network port that the protocol device  

would use to connect to the VIP module, for example 9800. 
 

 
Figure 7-4: UMD Setup 

7.3.5. Card Setup:  Server Setup 
The Server Setup screen enables the user to configure the VIP’s server based properties. 
 

• Enable Server: This parameter allows the user to enable or disable the VIP’s on board server.  The  
default setting is enabled. This setting must be disabled when the VIP is to be used in 
a larger system where the System Manager is being used to control the VIP. 
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• Enable GPId/VGPId: This parameter allows the user to enable or disable the ability to use GPIs  
 and VGPIs to load layouts and change sources on the VIP. 
 
• Enable DCPd:  This parameter allows the user to enable or disable the ability to use the  
    3000DCP desktop control panel with the VIP.  
 
• Enable SYMPHd: This parameter allows the user to enable or disable the ability to use  
    Symphony third party protocol to control the VIP. 

 

 
Figure 7-5: Server Setup 
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7.4. MVP/VIP MAESTRO SOFTWARE 

This section describes the VIP Maestro installation and usage instructions.  
 
Minimum PC Requirements for VIP Maestro: 

• Standard Pentium 4 class machine 
• 512MB RAM 
• 100Mb Ethernet Card, TCP/IP configured 
• 8MB Video card 
• 1024x768 screen resolution 
• Windows NT4, 2000, XP, Server 2003 operating system 
• CD-ROM drive 

 
Installation Instructions: 

1. Copy the MVP/VIP Maestro Installation software to your PC. 
 

2. Launch the installation by double-clicking the icon. 
 

3. Follow the installation instructions detailed on the pop-up windows of the installer. 
 

4. Upon completion, the desktop will show the “MVP/VIP Maestro” icon. 
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8. VIP ADVANCED MODES 

8.1. CHERRY PICK MODE (ROUTER MODE)  

When using the Cherry Pick Mode (Router mode), the user is required to be running firmware 1.3.1. 
 
8.1.1. Using On-board server 
To enable Cherry Pick mode (router mode) when using an on-board server, navigate to the I/O Setup 
option under the web interface and change the SDI Out Mode from Display to Router.  Once complete 
press the Submit button.   
 

 
Figure 8-1: Card Setup Layout for Cherry Pick Mode 
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8.1.2. Using PC Server  
To configure Cherry Pick mode using the PC server method, the user must be running installer version 
2.12.10 and firmware version 1.3.1. 
 
Using the System manager, navigate to the properties page of the card.  From the I/O Settings Tab 
change the SDI Output Mode: to Router.   Once changes are made, select the OK button and reboot the 
module. 
 
 

 
Figure 8-2: I/O Setting Tab for Cherry Pick Mode 

 

8.2. 3G OUTPUT MODE  

To configure the 3G Output Mode using the on-board server method the user must be running firmware 
version 1.3.1. 
 

8.2.1. Using On-Board server  
To enable 3G output mode from the web-interface, navigate to the I/O setup page and change the SDI 
Out Format to 3GSDI. Once complete, press the Submit button and reboot the module.  
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Figure 8-3: Card Setup Layout for 3G Output Mode 

 
 
8.2.2. Using PC Server 
When using PC server method, the user must be running installer version 2.12.10 and firmware version 
1.3.1. 
 
Using the System manager, navigate to the properties page of the card.  From the I/O Settings Tab 
change the SDI Output Format: to HD/3G-SDI.  Once changes are made, select the OK button and reboot 
the module. 
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Figure 8-4: I/O Settings Tab for 3G Output Mode 

 
 
8.3. MULTI-RES MODE  

To configure Multi-Res Mode the user must be running Maestro version 2.8.5 and firmware version 1.3.1. 
 
1. From the web-interface navigate to the Advanced Setup category and ensure that Dual Resolution 

Mode is set to enable. If it is not enabled, set the Dual Resolution Mode to enable and then reboot 
the module.  
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Figure 8-5: Setting Dual Resolution Mode using the Web Interface 

 
 
2. Next, connect to the card using Maestro.  
 
3. From the Tools tab within the Display Manager select the Resolution tab and then change the 

resolution to Multi1 – Multi-Resolution Device 1.  
 
4. Once complete, select the Apply button and then click the OK button. 
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Figure 8-6: System Configuration Window 

 
5. The resolution should now be displayed in a red box. 
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Figure 8-7: Maestro Screen Displaying Resolution 

 
6. Select the desired display and right click on the monitor icon. 
 
7. From the drop down menu select the Properties menu option and change the resolution to your 

desired output display.  
 
8. Once the resolution has been set, select the Apply button and then click OK.  
 
9. Follow the same prodecure to set the resolution for the other display.   
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8-8: Setting the Resolution for Monitor 2 

 
10. Once the resolutions have been set, navigate to the Tool tab and select the Save System Settings 

menu option.  
 

8.4. WALL MODE (1X2, 2X1) 

To configure Wall Mode the user must be running Maestro version 2.8.5 and firmware version 1.3.1. 
 
1. To enable Wall Mode using the Display Manager navigate to the Tools tab and then select System 

Configuration option. From within the system configuration, select your desired output resolution. 
 
2. Next, select the Advanced Setup option. Using the Configuration drop down menu, select the 

desired wall mode design and enter the display region coordinates, if appropriate. 
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Figure 8-9: Mastro Advanced Setup 

 
3. Once complete, select the Apply button and then the OK button. 
 
4. Maestro will reflect the change and the canvas will be set to the desired wall mode. 
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9. UPGRADING FIRMWARE 

The 7867VIPA8-DUO-HS, 7867VIPA16-DUO-HS, 7867VIPA18-DUO-HS, 7867VIPA24-DUO-HS, and 
7867VIPA32-DUO-HS possess firmware that is contained in a FLASH EPROM device.  From time to time 
firmware updates will be provided to add additional features to the unit.  
 
There are two methods of updating the firmware in the 7867VIPA8-DUO-HS, 7867VIPA16-DUO-HS, 
7867VIPA18-DUO-HS, 7867VIPA24-DUO-HS, and 7867VIPA32-DUO-HS units: File Transfer Protocol 
(FTP) and Serial Upload. Due to the large size of the firmware binary file, the FTP method is the preferred 
method of updating the firmware. 
 
Prior to initiating the upgrade process: 
• Confirm the version of code currently installed on the unit by using the front panel display. 
• Download the new application code from the Evertz FTP site (www.evertz.com). Unzip the file into a 

temporary working folder on your PC. 
 

9.1. UPGRADING THE FIRMWARE USING FTP 

You will need the following equipment in order to update the Firmware: 
 
• PC with available communications port and Ethernet network port. 
• “Straight-thru” serial extension cable (DB9 female to DB9 male) or (DB25 female to DB9 male). 
• Special upgrade cable supplied with the 7800FR frame.  This multi-coloured ribbon cable with a six pin 

header socket on one end and a female 9 pin D connector on the other end, (Evertz part number WA-
S76) which is normally in the vinyl pouch at the front of the manual binder.   

• Appropriate Ethernet cable as outlined in section 3.5. 
• Terminal program such as HyperTerminal. 
• New firmware supplied by Evertz. 
 

9.1.1. Step 1 – Determine the IP Addresses 
Before any FTP (file transfer protocol) upgrades can be initiated, the user must determine the IP address 
of the 7867VIPA card.  Both the PC/laptop and the unit must be on the same subnet for the FTP upgrade 
to work properly. Follow the procedure outlined in section 7.2.1 to set the IP address for the card. 
 

9.1.2. Step 2 – Establishing a Valid Network Connection 
1. Connect a crossover network cable from the PC/laptop to the card. 
 
2. Open a DOS window.  This can be accomplished by using the run command under the start button, 

type “cmd”.  See Figure 9-1 for more information. 
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Figure 9-1: Run Window 

 
3.  “Ping” the IP address of the module being upgraded to confirm that you have a valid network 

connection. In the command prompt window type: ping xxx.xxx.xxx.xxx (IP address of the module) 
and press <Enter>. 
 
If a proper network connection has been established, a “reply” is displayed on the DOS window. If 
there is a faulty network connection, a “Destination Host Unreachable” message is provided. If this 
occurs, either the IP addresses of the nodes should be verified or the network (Ethernet) cable is 
faulty. For more information, please see sections 3.5 and 7.2.1 of this manual. 

 
 

 

Figure 9-2: Pinging the IP Address 
 

9.1.3. Step 3 – Upgrading the Application Code 
4. Obtain the new application code and place it on the local drive of the PC. 
 
5. In the command prompt window type: ftp xxx.xxx.xxx.xxx (IP address of the module). 
 
6. Press the <Enter> key when prompted for a “Username”.   
 
7. Press the <Enter> key when prompted for a “Password”.  A message indicating that you have logged 

in is displayed. 
 
8. At the “FTP>” prompt type hash to turn on the progress indicator during the ftp upload.   
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9. At the “FTP>” prompt type quote site upgrade to put the unit in upgrade mode.  A message 

indicating that you are in upgrade mode is displayed. 
 
10. At the “FTP>” prompt type: put “the name of the file.bin” to send the firmware to the unit. 

(For example: put 7867VIP_1v0b310.bin) 
 
11. If the application file is not local to where you are performing the ftp, then include the path with the 

name (For example: put c:\firmware\ 7867VIP_1v0b310.bin). 
 

 
During this time it is mandatory that all power cycles of the unit be avoided. Figure 
9-3 displays a successful FTP session. 

 
12. A message indicating the successful connection to the module is displayed. 
 
13. File transfer occurs in several seconds, and the DOS window displays the “FTP>” prompt again. 
 
14. At the “FTP>” prompt type quit to exit the FTP procedure.   
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Figure 9-3: Upgrade Window 
 

9.1.4. Step 4 – Completing the Upgrade 
15. Disconnect the power to the unit and then plug it back into reboot the unit. 
 
16. You can now close the DOS window and disconnect the network cable. 
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9.2. UPGRADING THE FIRMWARE USING RS-232 SERIAL CABLE 

 
This method of upgrading the firmware will take over 15 minutes and is not 
recommended unless the FTP method fails. 

 
You will need the following equipment in order to update the Firmware: 
• PC with available communications port.  The communication speed is 115200 baud, therefore a 486 

PC or better with a 16550 UART based communications port is recommended. 
• “Straight-thru” serial extension cable (DB9 female to DB9 male) or (DB25 female to DB9 male). 
• Special upgrade cable supplied with the 7800FR frame.  This multi-coloured ribbon cable with a six pin 

header socket on one end and a female 9 pin D connector on the other end, (Evertz part number WA-
S76) is normally in the vinyl pouch at the front of the manual binder.   

• Terminal program that is capable of Xmodem file transfer protocol. (such as HyperTerminal) 
• New firmware supplied by Evertz. 
 

9.2.1. Step 1 – Setup 
17. Connect the 7800PB Serial Upgrade cable to the 2 row x 3 pin header on the bottom board.   
 
18. Connect the 9 pin connector on the end of the Serial Update cable to the PCs’ RS-232 

communications port. 
 
19. Start the terminal program. 
 
20. Configure the port settings of the terminal program as follows: 
 

Baud 115200 
Parity no 
Data bits 8 
Stop bits 2 
Flow Control None 

 

9.2.2. Step 2 – Invoke Upload Mode from the Terminal Program 
21. Power up the VIPA card. After the unit powers up, a banner with the boot code version information 

should appear in the terminal window. The cursor to the right of the word “BOOT>” should be spinning 
for about 5 seconds then the unit will continue to boot.  While the cursor is spinning press Ctrl-X to 
abort the boot-up process. 

 
 For example: 
 

PPC BOOT> 
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22. The following is a list of possible reasons for failed communications: 
 

• Defective Serial Upgrade cable. 
• Wrong communications port selected in the terminal program. 
• Improper port settings in the terminal program.  (Refer to step 20 for settings).  Note that 

HyperTerminal will not change port settings while connected.  Click on HyperTerminal’s 
“Disconnect” Button then click the “Reconnect” button to activate changes to the port settings. 

 
23. Hit the <ENTER> key on your computer once. 
 
24. Type the word “upload”, without quotes, and hit the <ENTER> key once. 
 
25. You should now see a prompt asking you to upload the file. 
 

9.2.3. Step 3 – Uploading the New Firmware 
26. Upload the “*.bin” file supplied using the X-Modem transfer protocol of your terminal program.  If you 

do not start the upload within 10 minutes the unit’s Boot code will time out.  You can restart the 
upgrade process by power cycling the unit. 

 
27. When the transfer is complete (can take up to 15+ minutes) the terminal will return to the PPCBOOT 

prompt. 
 

For Example: 
 

UPLOAD OKAY 
PPC BOOT> | 
 

 
 
28. The following is a list of possible reasons for a failed upload: 
 

• If you get the message "transfer cancelled by remote" you must restart the terminal program and 
load the bin file, then remove and install the module again. 

• The supplied “*.bin” file is corrupt. 
• Wrong file specified to be uploaded. 
• Wrong file transfer protocol used – make sure you specify Xmodem, not Xmodem 1K. 
• The PCs’ RS-232 communications port cannot handle a port speed of 57600. 
• Noise induced into the Serial Upgrade cable. 

 

9.2.4. Step 4 – Completing the Upgrade 
29. Power cycle the unit.  It should proceed through a normal boot up sequence. 
 
30. You can now close the terminal program and disconnect the RS-232 serial cable from the PC and the 

unit. 



7800FR MultiFrame 
7867VIPA-DUO Series: Advanced "DUO" Output Compact Multi-image Display Processor 

Page - 52 Revision 1.7  

10. CONFIGURING THE 3000DCP DESKTOP CONTROL PANEL 

Please note that this section assumes that the System Configuration Tool (SCT) has already been 
installed and configured.  
 

10.1. FOR SYSTEMS USING ONBOARD SERVER 

10.1.1. Creating the System and Setting up the Hardware 
 

1. Launch the System Configuration Tool (SCT).  
 
2. Select the Profile Settings tab.   
 
3. Select “Onboard Server” as the System Type, and enter the output card’s IP address in the text 

field marked “Enter the server address…” 
 
4. Press the Get from Server button at the top of the SCT to retrieve the system configuration for this 

system. 
 
5. Select the Hardware Setup tab.   
 
6. Add a DCP to the hardware list by filling in the name (e.g.: DCP1), type (DCP), and IP address 

fields.  See Figure 10-1. 
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Figure 10-1: Adding DCP to Hardware List 

 
7. Press the Send to Server button at the top of the SCT window to send the new configuration to 

the server. 
 

8. Select the Transfer Scripts button located at the top of the SCT.   
 

9. In the Transfer Scripts window that appears: 
 

For Local File, browse to and select: 
  
C:\ProgramFiles\Evertz\mvp\conductor\sys01\samples\dcpbasic.vssl    

 
For Server File select DCP Config from the dropdown menu.   

 
10. Press the Send to Server button to send the DCP configuration file to the server, and then close 

the Transfer Scripts window. 
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Figure 10-2: Transfer Scripts Window 

 

10.1.2. Enabling the DCP Server 
1. Connect a serial cable to the serial port of the output display card running the server.   
 

--------------------------------------------------------- 
|               Onboard Server Configuration              | 
|                 (7867VIPA8-DUO-HS 1.0.0)                | 
 --------------------------------------------------------- 
 ------------------------------------------------ 
Onboard Server: Enabled 
Onboard GPId: Disabled 
Onboard VGPId: Disabled 
Onboard DCPd: Disabled 
 ------------------------------------------------ 
(1) Display connection status 
(2) Enable server 
(3) Enable gpid 
(4) Enable vgpid 
(5) Enable dcpd 
 
(S) Save and Exit 
(X) Exit 
> > 1 

Figure 10-3: Onboard Server Configuration Menu 
 
2. Select (5) Enable dcpd and then select YES. 

 
3. Select (S) Save and Exit. 
 
4. Reboot the display card. 
 
 

10.2. FOR SYSTEMS USING PC SERVER 

1. Launch the MVP System Manager and navigate to the System menu and then select Modify 
System.   

 
2. Select the Hardware Setup tab.   
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3. Add a DCP to the Hardware list by filling out the name, type, and IP address fields.  See Figure 
10-4 below. 

 
4. When you have entered the information, click Add, and then OK.   

 
5. Select YES to restart the server. 

 

 
Figure 10-4: Adding the DCP to the Hardware List 

 
6. Click the Transfer Scripts button in the MVP System Manager.   

 
A Transfer Scripts window will appear.  
 
For Local File, browse to and select:  

 
C:\Program Files\Evertz\mvp\conductor\sys01\samples\dcpbasic.vssl   
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For Server File, select DCP Config from the dropdown menu (see Figure 10-5 below). 
 

 
Figure 10-5: Transfer Scripts Window 

 
7. Press the Send to Server button to send the DCP configuration file to the server. 
 
8. Close the Transfer Scripts window.   
 
9. Stop and restart the server. 
 

10.3. FOR PC AND ONBOARD SERVER – DCP SETUP 

1. Press the Select and Setup buttons on the DCP at the same time to enter the setup menu.   
 
2. Ensure that the DCP has the correct IP address as entered in the Hardware Setup Table.   
 
3. Verify all network settings.  Use the arrow buttons and rotary knob to enter network information.  Also 

ensure that the DCP is connected to the same network as the VIPA, and can be pinged from the PC 
running the Maestro application. 
 

It may take a few seconds in order for the DCP to connect.   
 
When it does, the dot-matrix display will go from displaying “No Clients Connected” to “Evertz 3000DCP 
DCPd@ xxx.xxx.xxx.xxx”. 

 
DCP presets are saved using the format “dnn-pnn”, where nn is the display number and preset button 
number.   
 
Use the Maestro software to save presets as a script (File > Save as script) using the described format.  
Maestro will automatically place the preset for the DCP in the correct location. 

 
Example: 

 
d01-p01, assigns the preset to display 1 preset button 1 
d01-p12, assigns the preset to display 1 preset button “shift” 2 (12) 
d04-p08, assigns the preset to display 4 preset button 8 
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10.4. UPGRADING THE 3000DCP  

The following are instructions on how to perform a firmware upgrade on the 3000DCP desktop control 
panel.  Please note that these are secondary methods to performing this upgrade, as it is normally 
completed in System Configuration Tool (Hardware Settings > Update). 
 
 
To use the serial method (baud rate = 115200, 8 data bits, N parity, 2 stop): 
 

1. Connect a serial port to the DB-9 serial connector on the back of the DCP. 
 

2. Hold down the Undo button and the Setup button while powering on the DCP. 
 

3. Using the serial terminal, hit CTRL-X at the prompt to put the unit in upgrade mode. 
 

4. At the prompt type “upload”. 
 

5. Use the terminal software to send the new firmware file using X-modem. 
 

6. After the firmware has been transferred, power cycle the unit. 
 
 
To use the FTP method: 
 

1. Open a dos window. 
 
2. At the prompt, type “ftp xxx.xxx.xxx.xxxx” where the x’s represent the IP address of the DCP. 
 
3. Hit <ENTER> for username and password. 
 
4. Type “put filename.bin” at the ftp prompt, where “filename.bin” represents the released 

firmware for the device. 
 
5. After the file has been transferred successfully, type “quit”. 
 
6. Power cycle the DCP. 
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11. SETTING UP PRESET LOADS 

11.1. SETTING UP A GPI PRESET LOAD - ONBOARD SERVER 

Please note that this procedure assumes an SCT has already been installed and configured.   
  
These instructions also assume the default install location of VIP software. If you have installed the VIP 
software elsewhere, please substitute your install location wherever the default location is referenced in 
the following sections: 
 
Initial configurations of GPI preset loads require the use of Windows Explorer and Notepad. GPI preset 
loads are configured through two files: actions.vssl and gpicfg.vssl 
 

11.1.1. The gpicfg.vssl File 
The gpicfg.vssl file maps actions to GPIs. These mapped actions are used to define what the gpi will do 
(e.g: load a preset).  
 
The syntax for the gpicfg.vssl file can be broken down into three parts:   

  
Part 1: obj GPISource ("DC1")    
 

This defines where the GPIs are connected. When running the Onboard Server, the name of 
the output card must be set to (“Local”), and only the GPIs connected to that card may be used 
for preset loads. For all other output cards in the system, the GPIs will operate normally.  
  

Part 2: obj gpi(1)  
 

This defines the GPI that will trigger the action (i.e.: the preset load).  
  

Part 3: { action = "presetload" }   
 

The action allows the system to link a GPI to an operation (i.e.: a preset load). The name of the 
action defined in the gpicfg.vssl will then be called in the actions.vssl file, the second 
configuration file. The actions.vssl file will define that operation.  

 
Example of a configured gpicfg.vssl file:  

  
                    obj GPISource ("DC1") {  
              obj gpi(1) { action = "presetload" }  
               }  

 
This configuration maps GPI 1 for DC1 to an action called “preset load”. 
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11.1.2. The actions.vssl File 
The actions.vssl file maps actions to a function. These mapped actions are used to define what action will 
be executed (e.g.: load a preset).  
 
The syntax for the actions.vssl file may be broken down into three parts:   

  
Part 1: obj ActRunScript("presetload")  
 

  This defines the name of the action. The name is referenced by gpicfg.vssl  
  

Part 2: script = "preset1.vssl"  
 

This defines the name of the script file (preset) that will be triggered by the action. The 
script file is created in Maestro during design mode.  

 
Part 3: display = 1  
 

This defines the output that the preset will be loaded on. This is a logical output number. 
Example DC1, 1,2,3,4, DC2, 5,6,7,8  

 
Example of a configured actions.vssl file:  

  
                   obj ActRunScript("presetload") {  
                   script = "preset1.vssl"  
                   display = 1  
                   }  

     
This configuration maps the action “presetload” to the preset “preset1.vssl” which will be loaded on the first 
output of the first display card in the system.                  
  

11.1.3. How to Set Up a GPI Preset Load 
Follow the instructions below to set up a preset load. 
 
 
Part 1: Editing the gpicfg.vssl File 
 
1. From a Windows 2000/XP operating system, using Windows Explorer, browse to the default install 

location of VIP software:  
 

C:\Program Files\ Evertz\ MVP\ Conductor \Samples 
 
2. Double-click the file called gpicfg.vssl, and then select Open With or Select Program from List, 

depending on your operating system.  
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3. Select Notepad, and click the checkbox beside Always use the selected program to open this kind 

of file and then click the OK button. 
 

 

Note:  When using Notepad, make sure that Word Wrap is disabled. A checkmark 
appears next to Word Wrap if it is enabled.  To disable Word Wrap, click on Word Wrap 
in the Format menu.  This will disable Word Wrap, removing the checkmark. 

 
  

   
  

 
4. When you are finished editing, save the file, making sure that Save as Type is set to All Files from the 

drop-down list.  
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Part 2: Editing the actions.vssl File 
 
1. From a Windows 2000/XP operating system, using Windows Explorer, browse to the default install 

location of VIP software:  
2.  

C:\Program Files\ Evertz\ MVP\ Conductor \Samples  
 
3. Double-click the file called actions.vssl, and select Open With or Select Program from List, 

depending on your operating system.  
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4. Select Notepad, and click the checkbox beside Always use the selected program to open this kind 
of file and then click the OK button.                                                                                                     

  

 

Note: When using Notepad, make sure that word wrap is disabled. A checkmark 
appears next to Word Wrap if it is enabled.  To disable Word Wrap, click on Word 
Wrap in the Format menu.  This will disable Word Wrap, removing the checkmark. 

 

 
  

5. When you are finished editing, save the file, making sure that Save as type is set to All Files from the 
drop-down list. 
  

 
  
Now that gpicfg.vssl and actions.vssl have been configured and saved, they need to be sent to the server. 
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Part 3:  Verifying Communication with the Onboard Server 
 

1. Launch the System Configuration Tool and select the System Configuration tab.   
 

2. Select System Type: Onboard Server and enter the IP address of the Onboard Server card in the 
text field as depicted below. 

 
3. Click on Get from Server at the top of the System Configuration Tool to retrieve configuration 

and verify communication with the Onboard Server. 
 
Part 4: Transferring the Gpicfg.vssl and Actions.vssl Files Using an Onboard Server 
 
1. Click on Transfer Scripts, which will cause the window below to be displayed. 

 

 
Figure 11-1: Transfer Scripts 

2. Click on the  button to open a browse window. Browse to where the gpicfg.vssl and actions.vssl 
files were saved.  

 
The default location is C:\Program Files\Evertz\MVP\Conductor\Samples 
 

3. Select actions.vssl and click open. The Transfer Scripts menu will appear again. 
 

4. From the Server File drop-down box, select Actions. 
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Figure 11-2: Transfer Scripts – Local File 

 
5. Click on Send to Server. The file actions.vssl will be sent to the server. 

 

6. Click on the  box to open a browse window. Browse to where gpicfg.vssl and actions.vssl files were 
saved.  

 
The default location is C:\Program Files\Evertz\MVP\Conductor\Samples. 
 

7. Select gpicfg.vssl and click open. The Transfer Scripts menu will appear again. 
 
8. From the Server File drop-down box, select GPI Config. 
 

 
Figure 11-3: Transfer Scripts – Server File 

 
9. Click on “Send to Server”. The file gpicfg.vssl will be sent to the server. 
 
The last step is to enable the GPId daemon. 
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Part 5: Enabling GPId Daemon on the Onboard Server 
 
The ability to load presets on a display is controlled by a daemon running on the server output card called 
GPId.  
 
This daemon is only used to load presets on a display, it is not required with normal GPI operation.  
 

 
The next few steps require a PC with HyperTerminal, a serial port, a serial cable, and a 
serial upgrade cable.  

 
1. Attach the serial upgrade cable to the server output card and launch HyperTerminal. 
 
2. Once connected with HyperTerminal, hit <ENTER> to display the serial menu of the server output 

card. 
 

-------------------------------------------------------- 
|                        Main Menu                       | 
|                  (7867VIPA8-DUO-HS 1.0.0)                | 
-------------------------------------------------------- 
(1) Network Configuration 
(2) Onboard Server Configuration 
(3) Utilities 
(4) Under Monitor Display Setup 
(5) Auxiliary Serial Port Setup 
(6) Display Wall Test 
(7) Hardware Test Menu 
(8) Engineering/Debug 
 
(X) Exit 

Figure 11-4: Main Menu 
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3. Select option (2) Onboard Server Configuration. 
 

 -------------------------------------------------------- 
|               Onboard Server Configuration             | 
|                  (7867VIPA8-DUO-HS 1.0.0)                | 
 -------------------------------------------------------- 
 ------------------------------------------------ 
Onboard Server: Enabled 
Onboard GPId: Disabled 
Onboard VGPId: Disabled 
Onboard DCPd: Disabled 
 ------------------------------------------------ 
(1) Display connection status 
(2) Enable server 
(3) Enable gpid 
(4) Enable vgpid 
(5) Enable dcpd 
 
(S) Save and Exit 
(X) Exit 

Figure 11-5: Onboard Server Configuration Menu 
 
4. Select (3) Enable gpid to enable the daemon required to load presets through GPIs. 
 

 -------------------------------------------------------- 
|               Onboard Server Configuration             | 
|                  (7867VIPA8-DUO-HS 1.0.0)                | 
 -------------------------------------------------------- 
 ------------------------------------------------ 
Onboard Server: Enabled 
Onboard GPId: Enabled 
Onboard VGPId: Disabled 
Onboard DCPd: Disabled 
 ------------------------------------------------ 
(1) Display connection status 
(2) Enable server 
(3) Enable gpid 
(4) Enable vgpid 
(5) Enable dcpd 
 
(S) Save and Exit 
(X) Exit 
> s 
Saving changes.. 
Please reboot for changes to take effect 

 
5. Select (S) Save and Exit to save the changes. Reboot the server output card for the changes to take 

effect. 
 
When the card has been re-booted, GPIs may be used to load the defined presets in the gpicfg.vssl and 
actions.vssl files. Please refer to the Maestro manual for more information on how to create the presets. 
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11.2. SETTING UP A VGPI PRESET LOAD – ONBOARD SERVER 

VGPIs are virtual GPIs sent by a 7800MVP-PTX or a third party device adhering to the VGPI 
protocol format.  
 
Initial configurations of VGPI preset loads require the use of Windows Explorer and Notepad. VGPI 
preset loads are configured through two files: actions.vssl and gpicfg.vssl 
 
Please note that this procedure assumes the System Configuration Tool has already been installed 
and configured.  
 
These instructions also assume the default install location of VIP software.  If you have chosen an 
alternate install location, please substitute your install location wherever the default location is referenced 
below.  
 

11.2.1. The gpicfg.vssl File 
The gpicfg.vssl file maps actions to VGPIs. These mapped actions are used to define what the VGPI will 
do (e.g.: load a preset). 
 
The syntax for the gpicfg.vssl file can be broken down into three parts:  

 
Part 1: obj GPISource ("Local")  

This defines where the VGPIs are connected. With an onboard server, this entry must be set to 
(“Local”), and only the VGPIs connected to the onboard server card can be used for the preset 
load. For onboard systems with two output cards, the VGPIs will operate normally for the card not 
running the server. 

 
Part 2: obj vgpi(1) 

This defines the VGPI that will trigger the action (the preset load). 
 

Part 3: { action = "presetload" } 
The action allows the system to link a VGPI to an operation (i.e.: a preset load). The name of the 
action defined in the gpicfg.vssl will then be called in the actions.vssl file (the second 
configuration file). The actions.vssl file then will define that operation. 

 
The following is an example of a configured gpicfg.vssl file 

 
                    obj GPISource ("Local") { 
              obj vgpi(1) { action = "presetload" } 
               } 

    
This configuration maps VGPI 1 for an onboard server to an action called “preset load”. 
 

11.2.2. The actions.vssl File 
The actions.vssl file maps actions to a function. These mapped actions are used to define what the action 
will do (e.g.: load a preset). 
 
The syntax for the actions.vssl file can be broken down into three parts:  
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Part 1: obj ActRunScript("presetload") 
This defines the name of the action. The name is referenced by gpicfg.vssl 

 
Part 2: script = "preset1.vssl" 

This defines the name of the script file (preset) that will be triggered by the action. The script file is 
created in Maestro during design. 

 
Part 3: display = 1 

This defines the output that the preset will be loaded on. This is a logical output number. 
 

The following is an example of a configured actions.vssl file 
 

obj ActRunScript("presetload") { 
script = "preset1.vssl" 
display = 1 
} 

    
This configuration maps the action “presetload” to the preset “preset1.vssl”, which will be loaded 
on the first output of the first display card in the system.                 
 

11.2.3. How to Set Up a VGPI Preset Load 
Follow the instructions below to set up a VGPI preset load. 
 
Part 1:  Editing the gpicfg.vssl File 
 

1. From a Windows 2000/XP operating system, using Windows Explorer, browse to the default install 
location of VIP software:  

C:\Program Files\ Evertz\ MVP\ Conductor \Samples 
 

2. Double-click the file called gpicfg.vssl, and then select Open With or Select Program from List, 
depending on your operating system. 
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3. Select Notepad, and click the checkbox beside Always use the selected program to open this 
kind of file and then click OK button.                                                                                                    

 

 

Note: When using Notepad, make sure that Word Wrap is disabled. A checkmark 
appears next to Word Wrap if it is enabled. To disable Word Wrap, click on Word 
Wrap in the Format menu and remove the checkmark. 

 

 
 
4. When you are finished editing, save the file, making sure that Save as type is set to All Files from 

the drop-down list.  
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Part 2: Editing the actions.vssl File 
 

1. From a Windows 2000/XP operating system, using Windows Explorer, browse to the default install 
location of VIP software:  

C:\Program Files\ Evertz\ MVP\Conductor\Samples 
 
2. Double-click the actions.vssl file, and select Open With or Select Program from List, depending 

on your operating system. 
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3. Select Notepad and click the checkbox beside Always use the selected program to open this 
kind of file and then click OK button.        

                                                                                             

 

Note: When using Notepad, make sure that Word Wrap is disabled. A checkmark 
appears next to Word Wrap if it is enabled. To disable Word Wrap, click on Word 
Wrap in the Format menu and remove the checkmark. 

 

 
  
 

4. When you are finished editing, save the file, making sure that Save as type is set to All Files from 
the drop-down list.  

 
 

 
 

Now that gpicfg.vssl and actions.vssl have been configured and saved, they need to be sent to the 
server. 
 
Part 3:  Verifying Communication with the Onboard Server 
 

1. Launch the System Configuration Tool and select the System Configuration tab.   
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2. Select System Type: Onboard Server. Enter the IP address of the onboard server card in the text 
field as depicted below. 

 
3. Click on Get from Server at the top of the System Configuration Tool to retrieve configuration 

and verify communication with the Onboard Server. 
 
Part 4: Transferring the Gpicfg.vssl and Actions.vssl Files Using an Onboard Server 
 
1. Click on Transfer Scripts, which will cause the window below to be displayed. 

 

 
Figure 11-6: Transfer Scripts 

2. Click on the  button to open a browse window. Browse to where the gpicfg.vssl and actions.vssl 
files were saved.  

 
The default location is C:\Program Files\Evertz\MVP\Conductor\Samples. 

 
3. Select actions.vssl and click open. The Transfer Scripts menu will appear again. 
 
4. From the Server File drop-down menu, select Actions. 
 

 
Figure 11-7: Transfer Scripts – Local File 

 
5. Click on Send to Server. The file actions.vssl will be sent to the server. 
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6. Click on the  button to open a browse window. Browse to where the gpicfg.vssl and actions.vssl 
files were saved.  
 
The default location is C:\Program Files\Evertz\MVP\Conductor\Samples. 

 
7. Select gpicfg.vssl and click open. The Transfer Scripts menu will appear again. 

 
8. From the Server File drop-down menu, select GPI Config. 
 

 
Figure 11-8: Transfer Scripts – Server File 

 
9. Click on Send to Server. The file gpicfg.vssl will be sent to the server. 

 
The last step is to enable the VGPId daemon 
 
Part 5: Enabling VGPId Daemon on the Onboard Server 
 
The ability to load presets on a display is controlled by a daemon called “VGPId”, running on the server 
output card.  
 
This daemon is only used to load presets on a display. It is not required with normal VGPI operation.  
 

 
The next few steps require a PC with HyperTerminal, a serial port, a serial cable, and 
a serial upgrade cable.  

 
1. Attach the serial upgrade cable to the server output card and launch HyperTerminal. 

 
2. Once connected with HyperTerminal, hit <ENTER> to display the serial menu of the server output 

card. 
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--------------------------------------------------------- 
|                        Main Menu                       | 
|                 (7867VIPA8-DUO-HS 1.0.0)                 | 
--------------------------------------------------------- 
(1) Network Configuration 
(2) Onboard Server Configuration 
(3) Utilities 
(4) Under Monitor Display Setup 
(5) Auxiliary Serial Port Setup 
(6) Display Wall Test 
(7) Hardware Test Menu 
(8) Engineering/Debug 
 
(X) Exit 
 

 
3. Select (2) Onboard Server Configuration. 
 
--------------------------------------------------------- 
|               Onboard Server Configuration              | 
|                  (7867VIPA8-DUO-HS 1.0.0)                 | 
 --------------------------------------------------------- 
 ------------------------------------------------ 
Onboard Server: Enabled 
Onboard GPId: Disabled 
Onboard VGPId: Disabled 
Onboard DCPd: Disabled 
 ------------------------------------------------ 
(1) Display connection status 
(2) Enable server 
(3) Enable gpid 
(4) Enable vgpid 
(5) Enable dcpd 
 
(S) Save and Exit 
(X) Exit 
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4. Select (3) Enable vgpid to enable the daemon required to load presets through VGPIs. 
 

--------------------------------------------------------- 
|               Onboard Server Configuration              | 
|                  (7867VIPA8-DUO-HS 1.0.0)                 | 
 --------------------------------------------------------- 
 ------------------------------------------------ 
Onboard Server: Enabled 
Onboard GPId: Disabled 
Onboard VGPId: Enabled 
Onboard DCPd: Disabled 
 ------------------------------------------------ 
(1) Display connection status 
(2) Enable server 
(3) Enable gpid 
(4) Enable vgpid 
(5) Enable dcpd 
 
(S) Save and Exit 
(X) Exit 
> s 
Saving changes.. 
Please reboot for changes to take effect 

 
5. Select (S) Save and Exit to save the changes. Reboot the server output card for the changes to 

take effect. 
 
When the card has been re-booted, VGPIs may be used to load the defined presets in the gpicfg.vssl 
and actions.vssl files. Please refer to the Maestro manual for instructions on how to create the presets. 
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12. SETTING UP PROTOCOLS 

Sections 12.1 to 12.4 explain how to set up the following protocols on the VIP system: 
 

• Image Video Protocol 
• TSL Protocol 
• X-Y Protocol 
• ASCII Protocol 

 
Only set up the protocols that are relevant to your system.   
 

12.1. SETTING UP VIP TO WORK WITH IMAGE VIDEO PROTOCOL 

1. Select either RS-422 or RS-232 serial operation by setting jumpers J33 and J34 to one of these two 
positions on the auxiliary daughter card of the display card.   

 
2. Power up the system. 
 
3. Set up the auxiliary (rear) serial port baud rate to match the router/switcher device. 
 

This is performed via the upgrade serial port on the front of the card.   
 
4. Select (5) Auxiliary Serial Port Setup from the main menu of the terminal program.   

 
Ensure the settings match those listed below: 

 
------------------------------------------------ 
|          Auxiliary Serial Port Setup           | 
|           (7867VIPA8-DUO-HS 1.0.0)             | 
 ------------------------------------------------ 
 ------------------------------------------------ 
Baud Rate:      115200 
Data Bits:           8 
Parity:           None 
Stop Bits:           2 
 ------------------------------------------------ 
(1) Set baud rate 
(2) Set number of data bits 
(3) Set parity 
(4) Set number of stop bits 
 
(S) Save and Exit 
(X) Exit 
> 

Figure 12-1: Auxiliary Port Setup Menu 
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5. Select (4) Under Monitor Display Setup from the main menu to set up the display card for Image 
Video protocol operation. 

 
------------------------------------------------ 
|          Under Monitor Display Setup           | 
|           (7867VIPA8-DUO-HS 1.0.0)             | 
 ------------------------------------------------ 
 ------------------------------------------------ 
 Protocol:     Image Video 
 Input Type:   serial 
 ------------------------------------------------ 
(1) Set protocol 
 
(S) Save and Exit 
(X) Exit 
> 

Figure 12-2: Under Monitor Display Setup 
 
6. Wire the serial connection from the router/switcher to the auxiliary serial port of the VIPA.   
 
7. Power-cycle the VIPA frame. 
 
8. Using Maestro, add a UMD to a video object by dragging and dropping it onto the video object.   
 
9. In Mode Settings > Mode > Function, select Protocol ID from the drop-down box. 
 
10. Set the Active Protocol ID to match the video mapping defined by the router/switcher. 
 
When the VIPA receives a command from the router/switcher it will now be displayed on the output 
display.  
 

12.2. SETTING UP VIP TO WORK WITH TSL PROTOCOL 

1. Select RS-422 serial operation by setting jumpers J33 and J34 to this position on the auxiliary 
daughter card on the display card.   

 
2. Power up the system. 

 
3. Set up the auxiliary (rear) serial port baud rate to match the router/switcher device. 

 
This is performed via the upgrade serial port on the front of the card.   
 

4. Select (5) Auxiliary Serial Port Setup from the main menu of the terminal program.   
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Ensure the settings match those listed below: 

Figure 12-3: Auxiliary Serial Port Settings 
 

5. Select (4) Under Monitor Display Setup from the main menu to set up the display card for TSL 
protocol operation.   

 
Ensure the settings match those listed below: 

Figure 12-4: Under Monitor Display Setup Settings 
 

6. Wire the serial connection from the router/switcher via the HD-15 connector.  
   

7. Power-cycle the VIP frame. 
 

8. Using Maestro, add a UMD to a video object by dragging and dropping it onto the video object.   
 

9. Navigate to Mode Settings > Mode > Function, and select Protocol ID from the drop-down box. 
 

10. Set the Active Protocol ID to match the video mapping defined by the router/switcher. 
 
When the VIPA receives a command from the router/switcher it will now be displayed on the output 
display. 

------------------------------------------------ 
|          Auxiliary Serial Port Setup           | 
|            (7867VIPA8-DUO-HS 1.0.0)            | 
 ------------------------------------------------ 
 ------------------------------------------------ 
Baud Rate:  38400 
Data Bits:  8 
Parity:           even 
Stop Bits:  1 
 ------------------------------------------------ 
(1) Set baud rate 
(2) Set number of data bits 
(3) Set parity 
(4) Set number of stop bits 
 
(S) Save and Exit 
(X) Exit 
>

------------------------------------------------ 
|          Under Monitor Display Setup           | 
|             (3000PPV v1.06 b1248)              | 
 ------------------------------------------------ 
 ------------------------------------------------ 
 Protocol:     TSL 
 Input Type:   serial 
 ------------------------------------------------ 
(1) Set protocol 
 
(S) Save and Exit 
(X) Exit 
> 
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12.3. SETTING UP VIPA TO WORK WITH X-Y PROTOCOL 

Use the following set of instructions to configure the VIPA to use the X-YI protocol. 
 

12.3.1. Creating the Text Files 
1. Create two text files named “router_src.cfg” and “router_dst.cfg”, and save both files to the compact 

flash card on the display card(s) in the VIPA system.  
 

Please use the following example to create these two files: 
 

router_src.cfg 
 

#  src id  string 
0 “name 1” 
1 “name 2”  
2 “name 3” 
3 “name 4” 

 
Example: 
Sample router_src.cfg file: 

0 name1 
1 name2 
2 name3 
3 name4 

 
router_dst.cfg 
 

# umd protocol id dst id 
0 1 
1 2 
2 3 

Figure 12-5: Sample Text Files 
Example: 
Sample router_dst.cfg file: 
 0 1 

1 2 
 2 3 
  
2. FTP both files to the compact flash cards of all display cards in the system: 

 
 C:\ftp “ip address of display card” 
 ftp>put router_src.cfg 
 ftp>put router_dst.cfg 
 ftp>quit 
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12.3.2. Setting Up the Display Card(s) 
1. Select either RS-422 or RS-232 serial operation by setting jumpers J33 and J34 to one of these two 

positions on the auxiliary daughter card of the display card.   
 
2. Power up the system. 
 
3. Set up the auxiliary (rear) serial port baud rate to match the router/switcher device. 
 
4. This is performed via the upgrade serial port on the front of the card.   
 
5. Select (5) Auxiliary Serial Port Setup from the main menu of the terminal program.   

 
Ensure the settings match those listed below: 

 
------------------------------------------------ 
|          Auxiliary Serial Port Setup           | 
|           (7867VIPA8-DUO-HS 1.0.0)             | 
 ------------------------------------------------ 
 ------------------------------------------------ 
Baud Rate:        9600 
Data Bits:           8 
Parity:           None 
Stop Bits:           1 
 ------------------------------------------------ 
(1) Set baud rate 
(2) Set number of data bits 
(3) Set parity 
(4) Set number of stop bits 
 
(S) Save and Exit 
(X) Exit 
> 

Figure 12-6: Auxiliary Serial Port Setup 
6. Select (4) Under Monitor Display Setup from the main menu to set up the display card for XY 

Integrator protocol operation. 
 

------------------------------------------------ 
|          Under Monitor Display Setup           | 
|           (7867VIPA8-DUO-HS 1.0.0)             | 
 ------------------------------------------------ 
 ------------------------------------------------ 
 Protocol:     XY Integrator 
 Input Type:   serial 
 ------------------------------------------------ 
(1) Set protocol 
 
(S) Save and Exit 
(X) Exit 
> 

Figure 12-7: Setting up XY Integrator Protocol Operation 
 

7. Wire the serial connection from the router/switcher to the auxiliary serial port of the VIPA.   
 
8. Power-cycle the VIPA frame. 
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9. Using Maestro, add a UMD to a video object by dragging and dropping it onto the video object.   
 
10. Navigate to Mode Settings > Mode > Function, and select Protocol ID from the drop-down box. 
 
11. Set the Active Protocol ID to match the video mapping defined by the router/switcher. 
When the VIPA receives a command from the router/switcher it will now be displayed on the output 
display.  
 
The command that we expect to see is as follows: 
 

S:02,0   = 02:  level 0, destination 2 
 = ,1:  source 1 

Figure 12-8: Command Displayed on the Output Display 
 

Therefore, using the above files as an example – we would display at UMD protocol id 1, the text string 
“name 2”. 
 

12.4. SETTING UP VIPA TO WORK WITH ASCII PROTOCOL 

12.4.1. Creating the Text File 
1. Create a text file named “router.cfg” and save it to the compact flash on the display card.  

 
Use the following example to setup the file: 

 
# Input id String 
0      Source 0 
1      Source 1 
2      Source 2 
3      Evertz MVP 

 
Sample: 

0 Source0 
1 Source1 
2 Source2 
3 EvertzMVP 

 
 

2. FTP the file to the compact flash cards of all display cards in the system: 
 

 C:\ftp “IP address of display card” 
 ftp>put router.cfg 
 ftp>quit 
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12.4.2. Setting Up the Display Card(s) 
1. Select either RS-422 or RS-232 serial operation by setting jumpers J33 and J34 to one of these two 

positions on the auxiliary daughter card of the display card.   
 
2. Power up the system. 
 
3. Set up the auxiliary (rear) serial port baud rate to match the router/switcher device. 
 

This is performed via the upgrade serial port on the front of the card.   
 
4. Select (5) Auxiliary Serial Port Setup from the main menu of the terminal program.   

 
Ensure the settings match those listed below: 

 
------------------------------------------------ 
|          Auxiliary Serial Port Setup           | 
|            (7867VIPA8-DUO-HS 1.0.0)            | 
 ------------------------------------------------ 
 ------------------------------------------------ 
Baud Rate:      115200 
Data Bits:           8 
Parity:           None 
Stop Bits:           2 
 ------------------------------------------------ 
(1) Set baud rate 
(2) Set number of data bits 
(3) Set parity 
(4) Set number of stop bits 
 
(S) Save and Exit 
(X) Exit 
> 

Figure 12-9: Auxiliary Serial Port Setup Menu 
 

5. Select (4) Under Monitor Display Setup from the main menu to set up the display card for ASCII 
protocol operation. 

 
------------------------------------------------ 
|          Under Monitor Display Setup           | 
|            (7867VIPA8-DUO-HS 1.0.0)            | 
 ------------------------------------------------ 
 ------------------------------------------------ 
 Protocol:     Philips ASCII 
 Input Type:   serial 
 ------------------------------------------------ 
(1) Set protocol 
 
(S) Save and Exit 
(X) Exit 
> 

Figure 12-10: Under Monitor Display Setup Menu 
 

6. Wire the serial connection from the router/switcher to the auxiliary serial port of the VIPA.  
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7. Power-cycle the VIPA frame. 
 
8. Using Maestro, add a UMD to a video object by dragging and dropping it onto the video object.   
 
9. Navigate to Mode Settings > Mode > Function, and select Protocol ID from the drop-down box. 
 
10. Set the Active Protocol ID to match the video mapping defined by the router/switcher. 
 
When the VIPA receives a command from the router/switcher it will now be displayed on the output 
display.  
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13. CONFIGURING FONTS 

The MVP installer comes with a selection of predefined fonts.  If installed to the default location, these 
fonts can be found at: 
 

C:\\Program Files\Evertz\MVP\Resources\Fonts 
 
To configure fonts on the VIPA, follow the procedure outlined below: 
 

1. Using the System Manager, click the Configure Fonts button. 
 

 
 

2. In the window that appears, click on the browse button, and then navigate to the save location for 
fonts. 

 

 
Figure 13-1: Select Font File 

 
3. When finished, you will send the fonts to the appropriate card. 
 

To send the fonts to a specific card, select the card in the Font Configuration window, and then 
click the Send Fonts to Selected Cards button. 
 
To send the fonts to all cards, do not select any card, and then click the Send Fonts to All Cards 
button. 

 
4. Reboot the display card. 

 
5. Open Maestro, and right click on the system.  From the menu that appears, choose Download 

System Configuration. 
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Figure 13-2: Maestro 

 
The fonts have now been successfully configured. 
 



7800FR MultiFrame 
7867VIPA-DUO Series: Advanced "DUO" Output Compact Multi-image Display Processor 

Page - 86 Revision 1.7  

14. VISTALINK® REMOTE MONITORING/CONTROL 

14.1. WHAT IS VISTALINK®? 

VistaLINK® is Evertz’ remote monitoring and configuration platform which operates over an Ethernet 
network using Simple Network Management Protocol (SNMP).  SNMP is a standard computer network 
protocol that enables different devices sharing the same network to communicate with each other.  
VistaLINK® provides centralized alarm management, which monitors, reports, and logs all incoming alarm 
events and dispatches alerts to all the VLPro Clients connected to the server.  Card configuration through 
VistaLINK® PRO can be performed on an individual or multi-card basis using simple copy and paste 
routines, which reduces the time to configure each module separately.  Finally, VistaLINK® enables the 
user to configure devices in the network from a central station and receive feedback that the configuration 
has been carried out. 
 
There are 3 components of SNMP: 
 
1. An SNMP manager, also known as a Network Management System (NMS), is a computer running 

special software that communicates with the devices in the network.  Evertz VistaLINK®-C 
Configuration Utility graphical user interface (GUI), third party or custom manager software may be 
used to monitor and control Evertz VistaLINK® enabled products. 

 
2. Managed devices, each with a unique address (OID), communicate with the NMS through an SNMP 

Agent. The 7867VIPA8/16/32-DUO-HS communicates directly with the manager using its internal 
Agent. 

 
3. A virtual database known as the Management information Base (MIB) lists all the variables being 

monitored, which both the Manager and Agent understand.  Please contact Evertz for further 
information about obtaining a copy of the MIB for interfacing to a third party Manager/NMS. 
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15. APPENDIX A  

15.1. DIN SPECIFICATIONS 

15.1.1. Evertz DIN1.0/2.3 Connector Details 

 
As I/O density increases and size decreases today’s broadcast manufactures are constantly looking for 
ways to find a happy medium between these two diametrically opposed concepts. One simple way is to 
move away from standard 75Ω BNC connectors and to begin using some smaller form factor 75 Ω 
connector. Recent developments from connector manufactures has resulted in the availability of a new 
type of connector quickly becoming popular to meet exactly this need. The connector is referred to as a 
DIN type connector. Sometimes mistakenly referred to as MiniDIN, Mini BNC or SMA connectors DIN type 
75 Ω connectors are becoming very popular both due to their high performance capability, easily 
supporting 3G applications, their obvious high density, and the fact that the connector offers a positive 
locking style connector instead of BNC’s compression style fit.  Evertz’s next generation of smaller high 
density applications must not only work well in terms of performance and signal quality. They must also 
support 3Gb/s signals, work well in difficult physical environments such as Trucks and OB vans. That is 
why for applications requiring a connector with a higher density than that of BNC while offering 3Gb/s 
performance and a positive lock onto their mating jack Evertz has chosen to use the DIN connector. 
 
The particular connector chosen is the DIN1.0/2.3 connector. This connector, originally established as a 
50 Ω connector for the telecommunications industry, has been redesigned as a 75 Ω connector for the 
broadcast industry.  The connectors are typically rated to 3.7-4Gb/s data rates (a 4Gb/s capable connector 
might be referred to as a 2GHz connector) and support typical mini hi-res cable or standard HD/3G cable 
depending on the connector. 
 
For small diameter cable, Belden 1855A is the cable Evertz uses as a reference, but of course any cable 
with appropriately matching specifications to that of Belden 1855A cable will work. When choosing a 
different cable take care to compare the AWG/diameter of the center conductor, the OD (outside diameter) 
of the outer shield, and the OD of the jacket (total cable OD), as the measurements that should be 
carefully matched to ensure the cable will properly perform with the DIN1.0/2.3 connectors that support 
this size cable. Information on 1855A style connector is included below. 
 
For large diameter cable, Belden 1694A is the cable Evertz uses as a reference but of course any cable 
with appropriately matching specifications to that of Belden 1694A cable will work. Information on 1694A 
style connectors is included below.  There are several other types of connectors available from different 
manufacturers, which meet the DIN1.0/2.3 specification, and these connectors will work too. We offer this 
information on 3rd party connectors as a result of empirical anecdotal testing and not as an endorsement 
of one vendor over another. Please contact Evertz for further support and information regarding DIN 
Specifications. 
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15.1.2. ITT Cannon DIN1.0/2.3 Connector Details 
The Cannon 75 _ 1.0/2.3 connector series are widely used in applications requiring a high density solution 
and have become a standard in telecommunications in many parts of the world. Designed to meet the 
requirements of DIN 47247 and CECC 22230, these connectors feature a push/pull coupling mechanism 
to ensure mating integrity and a snap-on interface for ease of connection. Due to their small size these 
connectors can be densely packed while providing significant space savings over other 75Ω connector 
products. 
 
Connectors and Tooling are available from ITT Cannon or your local ITT Cannon distributor. Additional 
information can be found at ITT Cannon’s website: www.ittcannon.com under: products, RF75, 1.0/2.3 
 
 

Electrical   

Impedance  75 Ω nominal  
Frequency Range  With 75 Ω connector on 75 Ω cable = 0 -2 GHz  
Voltage Rating  At Sea Level = 250 Vrms  
Insulation Resistance  1000 M Ω minimum  

Contact Resistance  
Inner contact = 6 m Ω typical maximum Outer contact 
= 2.5 m Ω maximum  

With 75 connector on 75 Ω cable and 
F=1GHz  0.1 maximum  
Mechanical   

Withdrawal Force, inner female contact  0.2 N (0.04 lbs.) minimum  
Withdrawal force, outer male contact  0.7 N (0.15 lbs.) minimum  

Insertion force between  jacks and 
plugs  10 N (2.24 lbs.) maximum  

Withdrawal force 
between  

jacks and 
plugs  0.9 N (0.20 lbs.) minimum  

Materials   Bodies and nuts: Brass  
  Inner male contact: Brass of Berylium Copper.  
  Inner and outer female contacts:Berylium Copper.  
  Insulators: PTFE or Thermoplastics  
  Crimp ferrules: Copper alloy  
Finish / Plating:   Contact surfaces: Gold over Nickel.  
  Bodies and crimp ferrules: Nickel or Gold over Nickel  

Environmental    

Temperature Rating   -40 degrees C to 85 degrees C  
General    

Connector Durability   500 matings minimum  
Standards   CECC 22230, DIN 47297, RC9333 (T54 only)  

 

http://www.ittcannon.com/
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15.1.3. ITT Cannon DIN1.0/2.3 Assembly Details 

 



7800FR MultiFrame 
7867VIPA-DUO Series: Advanced "DUO" Output Compact Multi-image Display Processor 

Page - 90 Revision 1.7  

15.1.4. Evertz OEM DIN1.0/2.3 Connector Details (CRIMP/CRIMP) for 1694A Assembly Details 
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15.1.5. White Sands DIN1.0/2.3 Connector Details (1 piece CRIMP) for 1855A 

 
 
SPECIFICATIONS: 
 

Impedance 75 Ohm 
Frequency Range DC – 3.0 GHz (dependent upon cable limitations) 
Insertion Loss <0.1 dB @ 1 GHz 
Cable Retention Force > 40 lbs. 
Center Pin Retention > 150 grams 
Mating Style Positive Locking 
Current Rating 2 Amps 
Working Voltage < 300 vrms 
Center Conductor Contact & Plating Phosphor Bronze with Gold Plate 
Body Material  Brass 
Body Plating Nickel 
RFI > 85  dB 

 
 
White Sands Engineering’s 1.0/2.3FP plug features a fixed pin, one-piece design which can be installed 
quickly and reliably in the field. It is compatible with our YR46940 mini RG59 precision video cables as 
well as Belden 1855A, Gepco VDM230, Commscope 7538B, Coleman 99401. White Sands can provide 
connectors and tools, or cable assembles terminated with 1.0/2.3FP or other connectors as needed. 
 
For more information on the 1.0/2.3FP and our entire line of fixed pin, one-piece connectors for mini 
RG59, visit our website at www.whitesandsengineering.com. 
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15.1.6. White Sands DIN1.0/2.3 Connector Details (1 piece CRIMP) for 1855A Assembly Details 

STEP 1: Use CPT7538125 tool to strip cable to 
proper dimensions as shown. Make sure there is no 
braid wrapped around the center conductor creating 
a short.  
 

 

STEP 2: Fold Braid back over jacket. Leave foil on 
dielectric, ensuring foil is smooth all around 
dielectric.  
 

 

STEP 3: Insert the center conductor and dielectric 
with foil into the center diameter of the connector. 
Push the connector onto the cable while rotatin the 
connection ½ a turn. Ensure cable is inserted 
completely into the connectior with no braid visible 
behind the connector.  
 
Note: Continuity test cable before crimping to ensure 
a good connection.  
 

 

STEP 4: Crimp one time on all 3 rings of the 
connector where shown using the .213 die on the 
ACT483 crimp tool.  
  
 
The positive locking mechanism in this connector ensure secure mating that will not be affected by 
vibration or accidental tugs on the cable. Connectors can only be unmated from high density panels using 
the 1.0REMTOOL. 
 
CPT7538125: Strip tool, ¼ “ x 1/8 “ for mini RG59 cable. 

 
ACT483: Crimp tool, .270” and .213” hex dies for mini RG59 connectors. 

 
1.0REMTOOL: Removal tool for 1.0/2.3FP connectors. 
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